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Simply Willing Overview 

This software program has been written to enable those of us with a 
simple estate to draw up a legal Last Will and Testament without 
having to pay extravagant legal fees. 
 
You can make as many Wills as you like, as frequently as you like, 
within your family BUT for the Wills to be valid they must be printed 
signed, independently witnessed and stored in a safe place. 
 
By using this simple software program called SimplyWilling and 
making your Will now can prevent a financial and administrative 
headache for your family when you die. 

WARNING - this is a simple form of Will that can be used in 
the following manner:   

For simple non-complex Wills that DO NOT involve 
Trusts, Corporations or distribution of rented or 
leased properties or more complex blended family 
situations.  
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Overview 

We all know we should write a Will, but it’s one of those things that many of us never seem to 
get round to.  

Sometimes we are scared off by the thought of the issues faced; sometimes it’s the cost of 
preparing a Will and sometimes we just decide, “I must do that but I’ll do it later”. It’s an often 
heard comment that many people die without ever having made a Will. 

If you do not have a valid Will in place prior to the time of your death this can mean chaos and 
financial worry for your family or dependants after you’ve gone. Without a valid signed Will, you 
can’t be sure that your money and property will be passed on according to your wishes. In fact 
the laws of the country you are residing in may apply and they will make a best effort to 
distribute your estate fairly. However this may not be in the same manner that you had in 
mind.  

Reasons to make a will 

If you die without a Will (called dying intestate), the intestacy rules that apply in your country 
determine who inherits what from your estate.  

Basically a Will is your written expression of HOW and to WHOM you want your estate to be 
distributed. The Will can also outline how you wish to be buried, cremated or whether you wish 
your body to be used for medical research purposes or for organ donation. The choice is yours.  

You can also use your Will to appoint guardians for any minor children (typically under 18), 
otherwise the courts will have a say in their future. It will also help to prevent your heirs from 
having to pay inheritance tax which may apply in your country. Keep in mind that “the age of a 
minor” may vary from country to country. 

We think that it’s a lot simpler and fairer for YOU to make the decision, now, rather than leave 
the decision for those of your relatives left behind after you are gone to make the decision. 

Making provision for your estate distribution to be managed in the manner that YOU wish is one 
of the most important aspects you can leave for your family and heirs and successors to ease 
the burden faced after the death of a loved one.  

You may also use this software as a general guide before meeting with your lawyer or estate 
planner to generate a pro-forma (a draft) document that can be used to simplify discussions 

with legal advisers. 

VERY IMPORTANT 

For the Will to be legal and capable of being executed upon your death, it must be signed in 
your own hand and witnessed by at least 2 independent persons, with date of signing and the 
date of witnesses signatures.   

The complete printed signed version should then stored in a safe place and the Executors 
advised of it’s location. 
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Introduction 

With this program you will be able to draw up your Last Will without having to pay legal fees. 
You can also be fully confident that it meets all legal requirements. 

Secrett Systems has researched the legal requirements for drawing up a Will in the following 
countries: 

• Australia  

• Eire  

• England  

• New Zealand  

• Northern Ireland  

• Scotland  

• South Africa  

• United States  

• Wales  

We are confident that this program will ensure that your Last Will and Testament will meet all 
legal requirements in these countries. 

However, the laws may change at any time and, particularly in the United States, may vary 
from state to state. If you are unsure, you should check local laws which you can easily do in 
your local library. 

Using the Program 

The program comprises a number of tabbed pages each of which collects some information 
from you in order to construct your Will. 

The About You and Executors pages are mandatory. 

The remainder are optional. However, they do help you to identify those items that you need to 
consider in making your Will. Remember the sole purpose in making a Will is to make it easy 
for your descendants and executors to process your estate in the manner that YOU wish. 
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TAB Overview 

 

TAB – About You 

 
For a Will to be legal you must provide the following details, in full, about yourself, the Testator: 

� Your full name which should include the name by which you are commonly known. 
� Your full address including street number and name, apartment or flat etc (if applicable). 
� The city in which you live. 
� The state, county or province in which you live. 
� The country in which you live. 
� Your postal (zip) code. 
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TAB – Executors 

 
The Executors page is mandatory. It collects details about your selected executors.  

When you draw up a Will you must appoint 2 executors. You should approach them beforehand to ensure that they are 
willing to act on your behalf. 

Your Primary Executor is the person who ensures that your wishes expressed in Last Will and Testament are carried 
out. It is their duty to: 

• To identify, locate and contact the beneficiaries of your Will. 

• Ensure that specific and general bequests are disbursed to the nominated beneficiaries in as speedy a manner 
as possible. 

• That the estate residue is disbursed to the primary beneficiary in as speedy a manner as possible after 
disbursement of specific and general bequests. 

Normally, an Executor may also be a beneficiary of your Will. However, since the law may vary from state to state in 
various countries, you should confirm this before making the bequest. 

Primary Executor 
Your Primary Executor is the person who will be called upon in the first place to execute the Will.  

If the Primary Executor is unable or unwilling to act, then the Secondary Executor will be asked to act. 

Secondary Executor 
Your Secondary Executor is a person appointed by you will act as executor to your Will in the event that the 
Primary Executor is unable or unwilling to act upon your behalf. 

Their duties are identical to that of the Primary Executor as are the details about that person. 

A Secondary Executor may also act alongside the Primary Executor to assist with the execution of your Last 
Will and Testament. 

Details 
The details to be collected for both Executors is: 

• Full name of both Executors. You should also include the name they are known by if that is different 
from their full, given name. 

• The full postal address for both Executors. 
• The current occupation for both Executors. 

TAB – Body Disposal 

 
The Body Disposal page is optional and is provided for those people who wish to make organ donations or have the 
body used for medical research purposes.  You do not have to select any of the options on this page, if you do not wish 
to do so. However, if you choose not to, then your remains may be disposed of in a manner in which you not approve, 
so again we make this age available so that you can your wishes expressed. 

This tab collects your wishes about how you want your body to be disposed. 

You may, for example, have thought about donating organs for transplantation purposes but your survivors may have 
other thoughts. 

On this page you can express your wishes and it is the duty of your executors to ensure that your wishes are 
fulfilled. 

Research Use 

If you want your remains to be used for Anatomical, Medical or Scientific Research, check the box. 
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Transplantation Use 

If you are willing to allow any useful organs to be harvested for Transplantation purposes, check the ‘Any 
Required’ check box. 

If you would prefer to specify certain organs such as your heart, kidneys and liver, check the appropriate 
boxes. 

Funeral Arrangements 

You may wish to be cremated rather than interred, or vice versa. Select the appropriate option in this section. 

Other Wishes 

In this section you enter any other wishes you may have about the disposal of your remains. You may, for 
example, prefer a non-religious funeral or you may want your ashes to be scattered in a particular place. Enter 
those wishes here. 

TAB – Minor Children 

 
In this area we are referring specifically to a topic called Guardianship in respect of children of the person making the 
will.  For more complex Guardianship requirements that can apply to adults or persons with disabilities we recommend 
you seek specialist legal advice! 

If you have Minor Children, it is extremely important that you provide for their care after your death.  

If no provision is made, then your minor children will usually come under the care of the state. In such a case, there is 
a strong likelihood that they would be separately fostered or adopted. 

It is strongly recommended that you appoint guardians for your children to ensure that this sort of event 
does not happen. 

Minor Children 
A Minor Child is a child who has not reached the age of majority. The age of majority varies from country to country 
and often from state to state. It is therefore important that you confirm the age of majority in your country.  

Typically, the age of majority is that age at which a person becomes eligible to vote. 

Primary Guardian 
Your Primary Guardian is the person who will be called upon in the first place to take on the care of your minor 
children. If the Primary Guardian is unable or unwilling to act, then the Secondary Guardian will be asked to 
act. 

Secondary Guardian 
Your Secondary Guardian is a person appointed by you will take on the care of your minor children in the 
event that the Primary Guardian is unable or unwilling to act upon your behalf. 

Age of Inheritance 
When you make a bequest to a minor child, you may choose to specify the age at which that child will receive 
their inheritance. 

This is known as the “Age of Inheritance”. 

If you do not specify an age of inheritance, your minor child will receive any bequests upon your death. 
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Details 
The details to be collected for both Guardians is: 

• Full name of both Guardians. You should also include the name they are known by if that is different 
from their full, given name. 

• The full postal address for both Guardians. 
• The current occupation for both Guardians. 

Note 
It could be considered unreasonable for the Guardians to take care of your children at their own expense.  

You should therefore  include a bequest to the guardian to financially assist with the care of your minor 

children. 

TAB – Specific Gifts 

 
On this page you can enter the details of any specific gifts you wish to make. 

Specific Gift 
A Specific Gift is an item of some sort that is uniquely identified. 

It may be, for example, a ½ carat diamond solitaire, 18 carat gold engagement ring or it may be a donation of a 
specific amount of money to your favourite charity. 

A Specific Gift is usually made to a named individual or organisation. 

Details 
• The details to be collected for Specific Gifts are: 
• Full name of the beneficiary. You should also include the name they are known by if that is different 

from their full, given name. 
• The full postal address for the beneficiary. 

TAB – General Gifts 

 
On this page you can enter the details of any general gifts you wish to make. 

General Gift 
A General Gift usually describes a group of similar items that are not uniquely identified. 

It may be, for example, a collection of books or all of your gardening equipment. 

A General Gift is usually made to a named individual or organisation. 

Details 
• The details to be collected for General Gifts are: 
• Full name of the beneficiary. You should also include the name they are known by if that is different from 

their full, given name. 
• The full postal address for the beneficiary. 
• The gift. 
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AB – Estate Residue T

 
On this page you can enter the details of you want the residue of your estate to be disbursed. 

 part of your estate that is left after the Executors have paid off any of your debts and 

sidue to be handed down to one individual or organisation. 

e you would 

 be collected for disbursement of the Estate Residue are: 

 they are known by if that is different 

or a specific reason, for example to the guardians of your 

ick the ‘Add’ button to add the gift to the list. Hitting the ‘Enter’ 

 that gift. The gift will be removed from the list and the details 

tal allocated has reached 100%, then double clicking an item to edit it will enable the details field. 

e click that gift and then hit the ‘Clear’ button. 

s described 

imply click the ‘Clear Form’ button. 

he list, the percentage allocated is summed. Once the total reaches 100% of the 
ate 

ide that you want to make changes to the percentages bequeathed, edit the items as described in 

Estate Residue 
The Estate Residue is that
disbursed your specific and general gifts. 

You may decide that you want all of the re

You may decide that you want to split the residue between several people or organisations. In this cas
bequeath a percentage to each. 

Details 
The details to

• Full name of the beneficiary. You should also include the name
from their full, given name. 

• The full postal address for the beneficiary. 
If you are making the beques• t to a person f
minor children, you should enter that purpose 

• The percentage of the Estate Residue being bequeathed. 

Adding the Gift to the List 
Once you have entered the details you can cl
key after you have entered the details of the gift will also add the gift to the list. 

Editing a Gift in the List 
To edit a gift in the list, simply double click
placed into the appropriate fields where you can then make the changes and add them back as described 
above. 

If the to

Deleting a Gift from the List 
To permanently delete a gift from the list, doubl

If the total allocated has reached 100%, then double clicking an item to permanently delete it a
above will enable the details field. 

Clear the Gifts List 
To clear all of the gifts in the list, s

Total Bequest 
As you add each gift to t
Estate Residue, the detail fields are disabled preventing you from bequeathing more than 100% of the Est
Residue. 

If you dec
the Edit section above. 
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TAB – Simultaneous Death 

 
On this page you may wish to specify that, if a beneficiary dies within a certain period of time after your death, they will 
be deemed to have died at the same time as you.  

Simultaneous Death 
Specific or general gifts made to that beneficiary will then, normally, go to the residue of the estate. You might 
choose to specify a simultaneous death to prevent any dispute from arising. 

Details 
The details to be collected for defining a period within which death is to be considered simultaneous are: 

• The period, usually in days, within which the death of a beneficiary is to be considered simultaneous with 
yours 

TAB – Witnesses 

 
In order for a Last Will and Testament to be considered valid, it must be signed by you in the presence of at least two 
(2) independent witnesses. 

On this page you may enter the details of those witnesses.  

Witnesses 
Although you must have to independent people witness your signing of your Will, you do not have to enter any 
details for them here. 

If you choose not to enter them, the space will be provided when you create and print your will. 

If you do choose to enter the details for your Witnesses, then you must enter all of the details described 
below. 

Details 
The details to be collected are: 

• Full name of each witness including the name by which they are usually known. 

• Current address of each witness. 

• Current occupation of each witness. 

TAB – Testament 

 

On this page you may enter your Testament. 

Testament 
Many people want to have their last say after they die. It may be that you wish to make final comments about your life, 
your family, your friends. You may wish to express regrets for past wrongs or to describe some event in your life that 
brought you great happiness. 

This is known as your Testament. 

You do not have to make a Testament but if you wish to do so, type it up on this page.  
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Detail 
The details to be collected for your Testament is: Entirely up to you!  

For example, you may wish: 

• To talk about the high points of your life. 
• To talk about the low ones. 
• To express regrets for ambitions not achieved. 
• To express your apologies for wrongs you have done. 
• To express thanks for past kindnesses shown to you. 
• There is no restriction on what you can or cannot say.  

TAB – Finished 

 

Finished! 
Unless you are browsing through the pages in this program, by the time you get to this page you should have collected 
all of the details you need to create your Last Will and Testament. 

However, you may like to step back through these pages to review 
everything first. 

To do so, just select each of the pages in turn. You can then make any 
changes that you might want to make. 

When you are ready, click 'Create Will'.  

 

Your Last Will and Testament will then be generated and displayed ready for printing and signing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

REMEMBER! A Will that is not properly signed and witnessed is invalid.  
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Essential tips - Saving Your Will 

You can save your work at any time. Doing so will not save the file in a form in which you can print it and have 
a legal Will. It merely contains the data you enter into your Will. 

You can save your Will by clicking the Save button at the 
bottom of the screen or by selecting Save from the File menu. 

To save your Will, you can click the 'Save' button.  

At any time in the future, you can revisit and revise your Will as 
required. 

Note that the saved Will is not in a format in which you can print it and have it legally valid. 

Essential tips - Printing Your Will  

To print your Will, you can click the 'Print' button below or right 
click on this window and select 'Print'.  

 

 

 

When you click the Print button 
this screen will come up as a 
reminder. 

  

 

 

 

 

 
You can select which printer you require or you can 
Print to PDF if PDF software is installed. 
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Essential tips - Exiting The Program 

When you have finished click the Close button to exit the 
program MAKE SURE YOU CLICK THE SAVE WILL button 1st!  

 

Essential tips - Signing Your Will 

For your Will to be considered legally valid and executable upon your death, you MUST: 

• Sign the Will in the presence of at least two (2) Independent witnesses. 

• Your witnesses must sign the Will in your presence at the same time as you sign it. 

• Your witnesses MUST NOT be beneficiaries of your Will. 

Essential tips - Safeguarding Your Will 

Having printed your Will and had it signed and witnessed, you should store it somewhere safe, for example in 
a safe deposit box at your bank.  

You should also advise the executors and close relatives where it is stored. 

Essential tips - Keep Your Will Up-To-Date  

Should your circumstances change (for example, if you become divorced or have children) don’t forget to 
update your will!  

Essential tips - Opening an Existing Will 

If you have already saved 
a previous Will generated 
by SimplyWilling you can 
Open up the file and then 
edit the details to update 
your Will at any time. 

You 
can 
open 
your 

Will by clicking the Open 
button at the bottom of 
the screen or by selecting 
Open from the File menu. 

Clicking the Open Will 
button will then ask you 
to select the Will file that 
you wish to open which 
will then allow you to edit 
the contents to add or 
change details in the 
previous Will. 
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Essential tips - Getting Help 

You can get context sensitive help at any time by hitting the F1 
button at the top of your keyboard. 

You can select Contents from the Help menu. 

You can also send and Email to Secrett Systems by selecting 
Support from the Help menu which will generate an email to 
support@secrett-systems.com      

 

Essential tips - Top level Menu Options 

  

  

 

 

 

mailto:support@secrett-systems.com
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Enduring Power Of Attorney 

This information is based on generally accepted practise in Australia.  

You should consult your own legal advisers in your country for more specific information.  

The Simply Willing software package does NOT cover Enduring Power Of Attorney actions 
or responsibilities in any way due to the specific legal requirements that need to be 
properly drawn up for your jurisdiction. 

 
What is an enduring power of attorney?  

An enduring power of attorney is a legal document which you can use to appoint a natural person or an organisation to 
make decisions about your property or financial affairs if you lose mental capacity. The person who makes an enduring 
power of attorney is known as ‘the principal'. The person who you appoint to make decisions for you is known as ‘the 
attorney'.  

Why make an enduring power of attorney?  

By making an enduring power of attorney, you are choosing who you want to manage your financial affairs should you  
lose the mental capacity to do these things for yourself. If you do not have an enduring power of attorney and you lose 
mental capacity, there may be no one with legal authority to manage your financial affairs. This may mean a court of 
law in your jurisdiction will need to appoint a financial manager for you. 

What is the difference between a ‘general' power of attorney and an ‘enduring' power of attorney? 

A general power of attorney ceases to have effect after you lose the mental capacity to make financial decisions. An 
enduring power of attorney will continue even after you lose mental capacity (e.g. if you develop dementia, have a 
stroke or sustain a brain injury in a motor vehicle accident). 

What powers apply under an enduring power of attorney?  

The enduring power of attorney can have the written power to make any decision or do anything about your finances or 
property which you could do yourself. These broad powers include such acts as selling, buying or leasing property (such 
as your house), making investments, accessing cash (including bank and investment accounts) and buying or selling 
stocks, bonds and shares. You can control the power you give to the attorney by placing limits or conditions in the 
enduring power of attorney egg; you can give the attorney limited authority to do specific tasks, such as paying regular 
bills but not selling property. If you wish to limit your attorney's powers you should seek legal advice.  

Can the attorney make any decisions apart from financial ones under an enduring power of attorney? 

The attorney can make decisions about your property or financial affairs. This means that they can operate your bank 
accounts, pay your bills, and sell or buy property (such as your house or shares) on your behalf. An enduring power of 
attorney cannot be used to make medical or decisions on lifestyle for you. However, you can appoint an enduring 
guardian to make these decisions and you can limit the powers they have if you wish.  

Who can make an enduring power of attorney?  

Anyone can make an enduring power of attorney if they have the mental capacity to understand the nature and effect 
of the power of attorney. They must be capable of understanding the range of decisions which the appointed enduring 
power of attorney can make on their behalf. They should also understand that the attorney can make decisions without 
consulting them. People of any age (not just older people) can make an enduring power of attorney. It is a safeguard 
for anyone who would like to choose who can manage their financial affairs on their behalf, if they lose their mental 
capacity. 

http://images.google.com/imgres?imgurl=http://www.thecarer.co.uk/images/10369.jpg&imgrefurl=http://www.thecarer.co.uk/LastingPowerOfAttorney.html&usg=__G1iWOL07HEszrw5QEjkfR8UXeZk=&h=260&w=200&sz=12&hl=en&start=70&um=1&tbnid=Flf-G5id6zKa4M:&tbnh=112&tbnw=86&prev=/images%3Fq%3D%2522enduring%2Bpower%2Bof%2Battorney%2522%26ndsp%3D20%26hl%3Den%26rls%3Dcom.microsoft:en-au:IE-SearchBox%26rlz%3D1I7GGIC_en-GB%26sa%3DN%26start%3D60%26um%3D1�
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Who should I appoint as my attorney?  

An attorney can have enormous power over your financial affairs. You should choose an attorney whom you trust and 
who will manage your finances in a responsible way. If your financial affairs are complicated, you should appoint an 
attorney who has the skills to deal with complex financial arrangements. You may wish to appoint a family member or a 
close friend as your enduring power of attorney. You can also appoint  a trustee company but fees will apply.  

How many attorneys can I appoint?  

You can appoint more than one attorney and when appointing more than one attorney, you should choose people who 
can cooperate with each other and who you trust to work together in your best interests. You can appoint your 
attorneys to act in differing manners as outlined below: 

• jointly and severally (this means that the attorneys can make decisions together or separately),  

• severally (this means that any one of the attorneys can make decisions independently of the other attorneys),  

• jointly (the attorneys must agree on all decisions).  

What if one of my attorneys dies or cannot continue for some reason?  

Your power of attorney may be affected if one of your attorneys dies or cannot continue in their role. This depends on 
how you appointed the attorneys. If you appointed them to act jointly and one of them is no longer willing or able to 
carry out their duties, then this will automatically end the enduring power of attorney. However, if you appointed your 
attorneys to act jointly and severally or severally then the enduring power of attorney will continue, even when one of 
them can no longer act. The remaining attorneys can keep making decisions for you, subject to the original limitations 
of powers granted under the original enduring power of attorney. 

 

VERY IMPORTANT NOTE 

For more information on Enduring Power Of Attorney requirements that suit 
your needs we strongly recommend that you seek legal advice in your own 
country to ensure that any Enduring Power Of Attorney that is drawn up 
meets the legal requirements of your country and that it is constructed in a 
manner that best suits your specific personal requirements.  
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WARNING - When NOT to use this Simply Willing Software 

It’s tempting to save money by setting up your own will, but we recommend that you seek 
professional legal advice to create a Will if: 

• If your estate is not simple, for example because you want to set up trusts, you have 
large amounts of real estate or are a partner in a business, then you are strongly 
encouraged to seek professional, legal advice. 

• Your circumstances are complicated or the way you wish to pass your assets on is very 
detailed 

• You have a beneficiary or family member or partner who is unable to care for 
themselves and is financially and physically dependent on you 

• You have been married before or have children from a previous marriage or are in a 
blended or de facto family situation 

• Your permanent home is not in the current country you are located in and/or you are not 
a citizen of the country you reside in at present. 

• You have property, or assets or funds located overseas 

• You run a business or a part owner of a business   

• You want to reduce or avoid tax obligations that may be applicable at death in your 
country. 

Should your situation cover more complex requirements, such as those listed above 
then we strongly recommend that you consult a professional adviser such as lawyer 
or solicitor or Wills expert to create a Will that specifically suits your circumstances. 
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For more help or advice  

contact support@secrett-systems.com  
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